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Introduction =0RIS

What is a Markup Language?

R/

%« A markup language is an artificial language using a set of annotations to
text that give instructions regarding the structure of text or how it is to be
displayed. Markup languages have been in use for centuries, and in recent

years have also been used in computer typesetting and word-processing
systems.

R

» A well-known example of a markup language in use today in computing is

Hyper Text Markup Language ( ), one of the most used in the

EX.

<?xml version="1.0"?>

<IDOCTYPE para>

<!—What does Bolivia export, and whither?-->

<para xml:lang="en"”> Bolivia exports tin Cuba &#231;a0.</para>>



http://en.wikipedia.org/wiki/HTML
http://en.wikipedia.org/wiki/WWW
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What Is XML Publisher?

< XML Publisher for PeopleSoft Enterprise is a template-based
reporting solution that separates the data extraction process
from the report layout and allows the reuse of extracted

application data into multiple report layouts.
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Oracle XML Publisher

“* Oracle has developed a standalone Java-based reporting
technology called XML Publisher used for streamlined

reporting and form generation

< A Primary feature of this product is the separation of the Data

extraction process from the Report Layout

< Using a single template, reports can be generate in many

output formats like .pdf, .rtf, .xls, .html etc.
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XML Publisher

oeparate dataflayout

Diata Lagic

— ML Fublisher — Fepart Output

Layout Template
hlore flexibility
Feduced maintenance
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Template Creation

To create a template, Template design helpers need to be used.

These are available in the form of Addins to standard text editors like
MS Word.

To download the MS Word plug-in, go to the navigation as shown below:

OoORrRACLE

Worklist

MutiChannel Console Audd to Fawvorites Sign out

Mew Window | Customize Page | S5,

|8

> Student Admissions
> Records and Enrollment
[ Curriculum Management -
> Financial Aid Design Helper
[» Student Financials
[ Academic Advisement

[ Contributor Relations _ -z _ :
> Set Up HRMS Plug-in for Microsoft Word (requires 2000 or later}

> Set Up SACR Facilitates the insertion of application data tags into RTF templates.
[ Enterprise Components
- Worklist

= Application Diagnostics
> Tree Manager
— Reporting Tools
= Query
> PSinVision
= XML FPublisher
- Setup
— Report Category
— Data Source
— Report Definition
— Content Library
— Translations
— Query Report Viewer
— Query Report Scheduler

— XMLP Report Search
— Report Manager
> PeopleTools
— Careers
— Change My Password
— My Personalizations
— My System Profile
— My Dictionary

<]

%) Local intranst L 100% -
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Template Creation

The ‘Template Builder’ toolbar is available in MS Word after download.

=)

serk Formak Tools Table Stimd o Help Template Builder Twpe a question For help -
S = P A= - =
: A4 Mormal

E Daka = Inserk = Prewview = Tools = Help -

[l

I Mew Microsoft Word Document.doc - Microsoft Word

T | ) 4 Read =

« Times Mews Roman - 1z

Tiris Template Builder toolbar
appears only after installing tie
XMLP softieare.

g

= m[E]=m ¢ il

S Draw - AutaShapes - Sa A= 2= = T - o - T

Page 1 Sec 1 i1 AL 1" Ln 1 Cal 1 REC| [TRE | [EXT | j[ovR IE=




XML Publisher Setup in PeopleSoft
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E Eanr! arce ! nnllnrlng

[ Pension

[» Campus Community

[ Student Recruiting

[> Btudent Admissions

[ Recards and Enrollment
[+ Curriculum Management
[ Financial Aid

[» Student Financials

[» Academic Advisement

[ Contributor Relations

[» SetUp HRMS

[ SetlUp SACR

[» Enterprise Components
[ Worklist

[> Application Diagnhostics

[ Tree Manager
=L Reporting Tools

— Data Source
— Report Definition

— Content Library
— Translations

— Query Report Viewer
— Guery Report Scheduler
— #MLF Report Search

— Rannrt Mananar

Main Menu = Reporting Tools =

I XML Publisher

Eclit "ML Publizhe

Regizter #ML-bazed report templates and tranzlstions . Run Guery-bazed reports. Usze enbanced search for XMLP report instances.

E Data Source
Register schema and zample data files for
ML Publizher data sources.

E" Translations

Fegister Tranzlstion XLIFF files for Repart
RTF templates and Contert Library RTF sub-
templates

E" XMLP Report Search
Locate XML Publizher report output wsing
enhanced search criteria.

Report Definition Content Library
Define reportz by azzociating Data Sources Create and maintain reuzable Sub-T
wyith layout Template files. defintions.

E" CGuery Report Viewer E Guery Report Scheduler

Run Guery-bazed XMLP reports real-time.
Wieswy ina wincdowe.

=Schedule Query-hazed XMLP repor
run bursted reparts.

ﬁ Setup
Prepare for uzing XL Publisher.

ElReport Categary
=l Design Helper
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Report Creation

XML Reports are created by separating the data extract from the
report layout. The data can be extracted from the PeopleSoft
database using different types of data sources like PS Query,
RecordSets etc.

Creating the Data Logic

Navigation:
Reporting Tools > Query Manager >Create New Query

1. Select the record name from which data needs to be extracted
and Click on Add record

2. Select the fields that are to be returned from the query.

3. Incorporate all criteria and joins in order to arrive at the right
query for the report output.

4. Save the query as public with a Name and Description.
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Report Creation

OoORrRACLE

Mew Window | Customize Page | ,

12

[ Campus Cormmunity
[ Student Recruiting
[» Student Admissions Data Source
[» Records and Enrollment
[= Curriculum Management
> Financial Aid
> Student Financials “Data Source Type: | PS Query
[ Academic Advisement *Data Source ID: [rvTEST |2 [ private Query
[+ Contributor Relations
> Set Up HRMS Add I
[ Set Up SACR
[ Enterprise Components Find an Existing Value | Add a Mew Value
[> Waorklist
[ Application Diagnostics
[ Tree Manager
~— Reporting Tools
[ Query
L PSinVision
= XML Publisher
- Setup
Data rce
— Repornt Definition
— Content Library
— Translations
— Query Report Viewer
— Qery Report Scheduler
— XMLP Report Search
— Report Manaqger
[ PeopleTools
— Careers
— Change My Password
— My Persaonalizations
— My Systerm Profile
— My Dictionary

Done

Find an Existing Value | Add a MNew Value

- |

&l

W) Lacal intranet w100 -

1. Navigate to Reporting Tools > XML Publisher > Setup - Data

Source
2. Add a new data source with the same name as the PS query name

saved in the previous step
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3. Generate .xml file and .xsd files from the Data source page and

save them.

ORACLE

[ Campus Community

[ Student Recruiting

[ Student Admissions

[ Records and Enroliment
[= Curriculum Management
[» Financial Aid

[ Btudent Financials

[> Academic Advisement

[- Contributor Relations

[ Set Up HRMS

[ Set Up SACR

[ Enterprise Components
[- Worklist

[+ Application Diagnostics
[» Tree Manager

~ Reporting Tools

[> Query

[ PSinVision

= XML FPublisher

— Content Library
— Translations
— Query Report Viewer
— Query Report Scheduler
— XMLF Report Search
— Report Manager

[ PeopleTools

— Careers

— Change My Passwaord

— My Personalizations

— My System Profile

— My Dictionary

Mew Window | Customize Page | &,

Data Source

Data Source Type:
Data Source ID:

PS Query
MYTEST

Description: [MyTEST | Active
Object Owner ID: | v|

Registered Date/Time: 11/26/08 T:21:16FPM Registered By: Ps

Last Update Date/Time:  11/26/03 5:02:35PM  Updated By: PS

Related Files

File Type File Generate File
Sample Data File MYTEST XML Reqgenerate
Schema File MYTEST X3SD Eegenerate

l:QReturn to Searchj IE

= save |

1 (3= MextinList)

Main Conkent

.a Local inkranet & 100%

-
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4. Save the .xml file generated onto to the local drive. This file will
be used to upload data into the template generated.

Workligt | MuliChannel Console | _Add to Favorites | _Sign out
B e R »| http:/flocalhost: 90/ps/psft/V-1858249120/MYTEST.xml - Win.
[» Student Recruiting 2 ) . . )
b Student Admissions Data Source mt__—;r !{—-\__F//F - |g, http: fflocalhost: 90)jps | |ﬁ| |£| |‘r’ah00! Search ||
b Rec?rds and Enroliment File Edit Wew Favorites Tools  Help Links **
[ Curriculum Management
I> Financial Aid 212 : : - ] l 2
v . i, fEf-18582491 20/MYTEST . xml
[> Student Financial sty -N. 5 U J o @
[ Academic Advise ) ~|
> Contributor Relatig Savein: |3 MyML x| = Bk E- B
E ge} Bp HRMRS = MYTEST ' queryname="MYTEST"
b Eﬁtergﬁse ] Lé = m lrww.w3.org/ 2001 /XMLSchema- =
b Worklist My Recent TespaceSchemaLocatlon: =
[> Application Diagnd ~ Documents =
[> Tree Manager — ) samp </EMPLID = =
~ Reporting Tools I_ |-26</EFFDT =
I Query Deskiop Imple data </NAME>
[- PS/nVision sam</DEPTID =
= XML Publisher ™ 0D </ J0BCODE >
b Sefup :) < /COMPANY >
- Re;ort Deﬂnitl My Documents "
— Content Libra [
) 8 e
— Query Report - =
— Query Report My Computer Imple data</NAME>
— XMLP Report sam</DEPTID =
— Report Manager I 0D </J0BCODE >
[» PeopleTools </ COMPANY =
— Careers My Network File name: I‘-.-1"'|"'TEEiT.:-:rnI j Save I
— Change My Passw Places | _| ",
— My Personalization Save az bype: #ML Files [%.uml) - Cancel | 3
JFMPITD = ] |
— My Systern Profile aﬂl{
— My Dictionary v rDone & Local intranet H100% -

H H Local intranet H100% -
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5. To load the data into the template, go to
Template Builder toolbar > Data > Load XML Data

I New Microsoft Word Document. doc - Microsoft Word

armat  Tools  Tahle Window  Help  Template Builder

&/

My Recent
Diocuments

&

%

il

My Metwork  File name: [MTTEST 2ami ~| Open |
Places
Filez of tvpe: IXML files [*_=ml] ;l Cancel |

]

i Draw - AutoShapes ~ ™ = ] g | . - - =

Page 1 Sec 1 i1 at 1" Ln 1 <ol 1 REC| |TRE| [EXT| |ovr| | BF
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6. A message confirms the successful load of data into the template

Gl New Microsoft Word Document. doc - Microsoft Word

EN ="

= REEERN=

A4 mMormal

e

= Times Mew Roman - 12 -
— — —

[v]

i Data ~ Insert ~ Prewview = Tools = Help ~

irndow

Py R

B 7

Help  Template Builder
u [=]= = - |3

O

[ 20% - @

|- |[=][X]
Tvwpe a question For help - X

Jd Read (=

ﬂé_,-:'

Microsoft Word

Data loaded successFully

(X

= E] === NE
i Draw - AukosShapes + = e I - b - - = T= e
Page 1 Sec 1 141 Ak Ln Col 1 REC| TRE| [ExT | jovr| | GF
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7. To design the report layout from the menu select
Insert > Table/Form > Wizard to insert a Table into the template

0§ Mew Microsoft Word Document.doc - Microsoft Word |:”E”X|

Format Tools Table ‘Window Help  Template Builder Twpe a queskion for help - X

=R 4
i Draw - AutasShapes ~ Y = L] g | S~ - - = z= =
Page 1 Sec 1 141 AL 1.9"  Lné Col 3 REC| [TRE| [ExT | [ovr | | EEK
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8. Select the fields to be displayed on the report output from the field
list

Mew Microsoft Word Document.doc - Microsoft Word |:||E||X|

Tools Table Window Help  Template Builder Type a question For help - M

I 'I Find Mext |

SO @numrows

- O @gueryname
-0 @xmins:i=si

Lo O @xcsiinoMamespaceSchemalocation
Cl-E3 Row

: @rownumber
Ernplid

EFFdt

Marne

Dieptid
Jobcode
Comparny

ooooooao

Example
o Calculation I vI I on Grouping
[~ Force LTR. Direction
. Imserk I Close I Help
-+ |Please select a node in the tree.
S
- =]
¥
= 1 ] >
i Draw - Autoshapes ~ Y = F] g | - -

Page 1 Sec 1 11 AL 1.9" Ln & Col 3 REC | [TRE| [EXT | |OWR [EES
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9. Save the document in .rtf format.

4 MyTest. rtf - Microsoft Word

Tools Table indoww Help  Template Builder

Jobcoide

i Draw = AautoShapes ~ S E= = g | - - =

Page 1 Sec 1 11 Ak 1" Lm 1 Col 1 FREC | TRE | EXT | |OWR
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10. Register the Report Definition with the Report name and Data
Source id already created

ORACLE"

MultiChannel Congole | _Add to Favo : | _Sign out

e -~ MNew Window | Customize Page | o5
[ Student Recruiting
I» Student Admissions Report Definition

[ Records and Enrollment ; -
[> Curriculum Management Find an Existing Value | Add & New Value

[ Financial Aid Report Hame: MYTEST

[ Student Financials
[> Academic Advisement *Data Source Type: | P& Query ~ |
[> Contributor Relations
[> Set Up HRMS Data Source ID: |MYTEST f@ [l private Query
[ SetUp SACR
[ Enterprise Components
[ Worklist
I> Application Diagnostics Find an Existing Value | Add a Mew Value
[ Tree Manager
~ Reporting Tools
[+ Query
[ PS/nVision
= XML Publisher
[» Setup
— Data Source

— Content Library
— Translations
— Query Repor Viewer
— Query Report Scheduler
— XMLP Report Search
— Report Manager

[ PeopleTools

— Careers

— Change My Password

— My Personalizations

— My System Profile

i ME DiC‘tiOﬂa[E |

Add
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11. Enter the data on the Report definition page as shown

ORACLE’

[ Campus Community
[ Student Recruiting
[» Student Admissions
[ Records and Enrollment
[ Curriculum Management
[* Financial Aid
[» Btudent Financials
[» Academic Advisement
[> Contributor Relations
[» SetUp HRMS
[» Set Up SACR
[+ Enterprise Components
[ Worklist
[ Application Diagnostics
[> Tree Manager
~ Reporting Tools

[ Query

[» PSnVision

= XML Publisher

[» Setup
— Data Source

— Content Library
— Translations
— Query Report Viewer
— Query Report Scheduler
— XMLP Report Search
— Report Manager

[ PeopleTools

— Careers

— Change My Password

— My Personalizations

— My Systern Profile

— My Dictionary

Al

[ Definiion Y Template ) OQutput % Security ) Bursting |

Home

MuttiChannel Cansole

Add to Favorites | _Sign out

Mew Window | Customize Page | h,, s}

Report Name: MYTEST

(E-'- ) ({ElUpdate.l’Display:] (gﬂlnclude Histoly) (@CorrectHistory)

Data Source Type: PS Query
Data Source 1D: WMYTEST
Data Source Description:  MYTEST
Report Description: [This is my XKL |
*Report Status: | Active w |
*Report Category ID: |ALLUSER |@, ANl Peoplesoft User
Object Owner 1D: |Pe0p|eTooIs v|
Template Type: CPOF @RTF O eText
~ | Days Before Purge: []
Registered Date/Time: Registered By:
Updated Date/Time: Updated By:
Download: Data Schema Sample Data
E| B save

Il




Putting Customer First

12. On the template tab, upload the Report template from the local
drive by clicking on the Upload button

ORACLE
T

I Campus Community ) New Window | Customize Page | 15,

[ Student Recruiting
[> Student Admissions /_Definition " Template % Output " Security ) Bursting
[ Records and Enrollment
[> Curriculum Management Report Hame: MYTEST
[ Financial Aid
[ Btudent Financials £ First I°J 1 of 1
[> Academic Advisement
I Contributor Relations Template ID: MYTEST_- Default Template
[ Set Up HRMS N
I Set Up SACR Description: | |
[ Enterprise Components * . English w - w
b Waorklist Language Code: | Channel: | |
[ Application Diagnostics
[» Tree Manager
[~ Reporting Tools Effective Date: 11/26/2008 [ [=]
[+ Cluery
= ¥ML Publisher
[ Setup Template File: MyTest.rif
— Data Source

— Report Definition

— Content Library Click on tiiis button

— Translations to Upload the rtf file

— Query Report Viewer B save |
— Query Report Scheduler
— XMLP Report Search
— Report Manager

[ PeopleTools

— Careers

— Change My Password

— My Personalizations

— My Systemn Profile

— My Dictionary

Worklist MultiChannel Console | _Add to Favorites Sign out

Template Files i First "1 1 of1 [® Last

Upioad 3] Downioad | Preview |

r=| Update."DispIay) @ Include Histoly:] @Colrect Histon,r:]

Il
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13. On the Output tab, specify the Report output format type and
destination where the output needs to be generated

ORACLE’

Home | Worklist | MuliiChannel Console | _Add to Favorites | _Sign out
I Cam i ) Mew Window | Customnize Page |
pus Community DIEW (VINGOW hEER
[ Student Recruiting
[> Student Admissions [ Definiion | Template | Output % Security | Bursting
[» Records and Enrollment
[+ Curriculum Management Report Name: MYTEST
[» Financial Aid
> Student Financials General
L PDF report output may be edited
[ Contributor Relations
[ Set Up HRMS Runtime Output Format Options
[ Set Up SACR Format Type
[- Enterprise Components
> Worklist FI -
[» Application Diagnostics PDF
[» Tree Manager
~ Reporting Tools RTF
[ Query
[> PSinVision s
= XML Publisher
[» Setup

— Data Source

— Content Library
— Translations
— Query Report Viewer
— Query Report Scheduler
— XMLFP Report Search
— Report Manager
[ PeopleTools
— Careers
— Change My Password
— My Personalizations
— My Systemn Profile
— My Dictionary |

Default

m
!!!!‘%
OO0O0R

(E"' ) (@Updatemisplay] @Include History:] @CorrectHistory)
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14. On the Security tab, specify the report viewers - either a specific
user id or a role that will identify the list of report viewers

ORACLE

Home | Worklist | MultiChannel Console | Add to Favorites | _Sign out

I Campus Community )| Mew Window | Customize Page |
[» Student Recruiting
[> Student Admissions [ Definiion |} Template " Qutput " Security Y Bursting |
[> Records and Enrollment
[ Curriculum Management Report Name: MYTEST
[ Financial Aid
I> Student Financials Report Viewers
[> Academic Advisement . " -
W ewe
I Contributor Relations Allowr vi r ID assignment at report runtime
Lo H: oS Report Viewers i view Al First 4] 1 o1 [M] Last
[> Enterprise Components 1D Type Distribution 1D Description
[ Worklist @ | |Q =
[ Application Diagnostics
[> Tree Manager
~ Reporting Tools [E"' & Update."DispIay) 4@ Include History) @Correct History)
[ Query
[ PSInVision B save
= XML Publisher —I
I» Setup

— Data Source

— Report Definition

— Content Library

— Translations

— Query Report Viewer

— Query Report Scheduler

— XMLP Report Search
— Report Manager
[: PeopleTools
— Careers
— Change My Password
— My Personalizations
— My System Profile
— My Dictionary |
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15. Setup Bursting options in order to use the same report template
multiple times for like sets of data,

ORACLE’

[> Campus Community
[ Student Recruiting
[ Student Admissions
[> Records and Enrollment
[> Curriculum Management
[> Financial Aid
[ Student Financials
[ Academic Advisement
[> Contributor Relations
[ Set Up HRMS
[ Set Up SACR
[- Enterprise Components
[ Worklist
[ Application Diagnostics
[> Tree Manager
~ Reporting Tools
[ Query
[ PSinVision
= XML Publisher

[ Setup

— Data Source

— Content Library
— Translations
— Query Report Viewer
— Query Report Scheduler
— XMLF Report Search
— Report Manager

[ PeopleTools

— Careers

— Change My Passwaord

— My Personalizations

— My System Profile

— My Dictionary

b

[ Definition ' Template | Output

Sign out

Mew Window | Customize Page | B 2

Y Becurity ' Bursting

Report Name:
Bursting

MYTEST

Burst by:

[Main Content

Security Join Table: | |

Security Field:

Security ID Type:

Field Mapping

Security Join Table Field Data Source Field

Search Keys

Search Field

= R P A P N k)
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16. Save the Report Definition

a CI E!
OR Home MultiChannel Conso
[> Campus Community &) Mew Window | Customize Page | u )
[» Student Recruiting
I Student Admissions | Definion " Template | Output Y Security | Bursting
[» Records and Enrollment
[» Curriculum Management Report Name: MYTEST
[» Financial Aid .
> Student Financials
[» Academic Advisement . _
[» Contributor Relations Burst by: | A |
> SetUp HRIS
[» SetUp SACR
[ Enterprise Components Template controlled by:
E :Upf;rr;; on Diagnastics Template Application Criteria
b Tree Manager Data Value Template ID Language =
— Reporting Tools | |
[> Query
[ PSinVision
= XML Fublisher =
b Setup
— Data Source . .
Securty JomTaike: | |
— Content Library Security Field: Security ID Type:
— Translations = . .
— Query Report Viewer Field Mapping
— Query Report Scheduler Security Join Table Field Data Source Field
— XMLP Report Search
— Report Manager
[» PeopleTools B
~ Careers
— Change My Password Search Field
— My Personalizations
— My System Profile L |
— My Dictionary ] = A TP T PP W 9 B! )
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17. In order to view the report output go to :
Reporting Tools &> XML Publisher > Query Report Viewer and choose
the report name that you just created and click in the View report link

oOoRACLE
(Mens — g

[ Campus Community
[» Student Recruiting
[ Student Admissions

Workliet | _MultiChannel Console Sign out

[

Mew Window | Customize Page | B,

[ Records and Enrollment
[ Curriculum Management
[* Financial Aid
[» Student Financials
[» Academic Advisement
[» Contributor Relations
[ Set Up HRMS
[» Set Up SACR
[- Enterprise Components
[ Worklist
[- Application Diagnostics
[ Tree Manager
== Reporting Tools
[+ Cuery
[ PSinVision
= XML Fublisher
[ Setup
— Data Source
— Report Definition
— Content Library
— Translations
— Query Report Viewer
— Query Report Scheduler
— XMLP Report Search
— Report Manager
[- PeopleTools
— Careers
— Change My Password
— My Personalizations
— My System Profile
— My Dictionary

£

Query Report Viewer
Enter any information you have and click Search. Leave fields blank for a list of all values.
*Search by: |Rep0rt MName MYTEST

Search | Advanced Search

Search Results
Report Definition

* | begins with

Show Template Prompts

omize | Find | t
Report Name Description Data Source ID Burst View Report
MYTEST This is my XML MYTEST M View Report
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18. The output is generated with the template designed and opens in a

new window as shown below:

[ Campus Community
[> Btudent Recruitin
[ 61 i i

Home | ‘Worklist | MultiChannel Console | Add to Favorites | _Sign out

New Window | Customize Page | B,

{= G - Windows Internet Explorer |- ||E||§| )
e—te—= blank for a list of all values.
L SAS M |ﬁ, http:/flocalhost:onps % | ¥4 | X | [vahoo! Search | Ee |I'u'|‘('TEST
File Edit Wiew Favorites Tools  Help Links **
* & @ [ i
~ ew £ First =1 1 of1 L2 Last
ACC = 'Bource ID *fFormat  Burst View Report
Emplid Effdt Name Deptid Johcode BT N View Report
PADO2 1996-01- | Walker,Gail K 95700 170055
01
PAODOS 1996-04- | Sitverstein Jacob 95000 290000
01
PAD14 19935-03- | Sorensen Elizabeth | 95100 300015
0
PAO2D 1995-01- | Carr Kitty C 95000 300000
01
PADO3 1996-01- | Quren. Tom 95700 120015
01
PAODO9 1995-04- | Howard_ Sheila 95700 170065
0
PAO1S 1995-03- | Webster, Holly 95800 420110
01
PAN21 1995-01- | Connor Maureen 95600 590005 b
Done & Local intranet H100% < — —_-—_—
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About SOAIS

SOAIS is a provider of Enterprise IT and Process outsourcing solutions.
Since its inception SOAIS has expanded at a tremendous pace and has
garnered customers from both mid-market segment and Fortune 100
companies. We have experience in managing ERP applications as well as
in providing high value services around packaged enterprise applications
such as PeopleSoft and Oracle. Our experience in the business process
outsourcing area fully extends our services footprint to provide end to

end enterprise wide solutions.

Please feel free to clarify queries or provide
feedback on this presentation at
http://www.soais.com/askexpert.html




